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Safety Information

For your own safety and the safety of others, and to prevent damage to the equipment and
vehicles upon which it is used, it is important that the accompanying Safety Information be read
and understood by all persons operating, or coming into contact with, the equipment. We suggest
you store a copy the book near the unit in sight of the operator

This product is intended for use by properly trained and skilled professional automotive
technicians. The safety messages presented throughout this manual are reminders to the
operator to exercise extreme care when using this test instrument.

There are many variations in procedures, techniques, tools, and parts for servicing vehicles, as
well as in the skill of the individual doing the work. Because of the vast number of test applications
and variations in the products that can be tested with this instrument, we cannot possibly
anticipate or provide advice or safety messages to cover every situation. It is the automotive
technician’s responsibility to be knowledgeable of the system being tested. It is essential to use
proper service methods and test procedures. It is important to perform tests in an appropriate and
acceptable manner that does not endanger your safety, the safety of others in the work area, the
equipment being used, or the vehicle being tested.

It is assumed that the operator has a thorough understanding of vehicle systems before using this
product. Understanding of these system principles and operating theories is necessary for
competent, safe and accurate use of this instrument.

Before using the equipment, always refer to and follow the safety messages and applicable test
procedures provided by the manufacturer of the vehicle or equipment being tested. Use the
equipment only as described in this manual.

Read, understand and follow all safety messages and instructions in this manual, the
accompanying safety manual, and on the test equipment.

Safety Message Conventions

Safety messages are provided to help prevent personal injury and equipment damage. All safety
messages are introduced by a signal word indicating the hazard level.

Indicates an imminently hazardous situation which, if not avoided, will result in death or serious
injury to the operator or to bystanders.

A WARNING

Indicates a potentially hazardous situation which, if not avoided, could result in death or serious
injury to the operator or to bystanders.

A CAUTION

Indicates a potentially hazardous situation which, if not avoided, may result in moderate or minor
injury to the operator or to bystanders.



Safety Information Important Safety Instructions

Safety messages contain three different type styles.

= Normal type states the hazard.
= Bold type states how to avoid the hazard.
= |talic type states the possible consequences of not avoiding the hazard.

An icon, when present, gives a graphical description of the potential hazard.

Example:
A WARNING

Risk of unexpected vehicle movement.
* Block drive wheels before performing a test with engine running.
A moving vehicle can cause injury.

Important Safety Instructions

For a complete list of safety messages, refer to the accompanying safety manual.

SAVE THESE INSTRUCTIONS
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Using This Manual

This manual contains tool usage instructions.

Some of the illustrations shown in this manual may contain modules and optional equipment that
are not included on your system. Contact a sales representative for availability of other modules
and optional equipment.

The following conventions are used.

1.1 Conventions

1.1.1 Bold Text

Bold emphasis is used in procedures to highlight selectable items such as buttons and menu
options.

Example:

* Press the Y/v button.

1.1.2 Symbols

The following types of arrows are used.
The “greater than” arrow (>) indicates an abbreviated set of selection instructions.
Example:
= Select Utilities > Tool Setup > Date.
The above statement abbreviates the following procedure:

1. Navigate to the Utilities button.

2. Use the Thumb Pad to navigate to and highlight the Tool Setup submenu.

3. Use the Thumb Pad to navigate to and highlight the Date option from the submenu.
4. Press Y/v to confirm the selection.

The solid arrows (4, », ¥, A) are navigational instructions referring to the four directions of the
Thumb Pad.

Example:

* Press the down ¥ arrow.



Using This Manual

Conventions

1.1.3 Terminology

The term “select” means highlighting a button or menu item using the Thumb Pad and pressing
the Y/v' button to confirm the selection.

Example:
= Select Reset.
The above statement abbreviates the following procedure:

1. Navigate to and highlight the Reset button.
2. Press the Y/v button.

1.1.4 Note and Important Messages

The following messages are used.

Note
A NOTE provides helpful information such as additional explanations, tips, and comments.

Example:

NOTE:
For additional information refer to...

Important

IMPORTANT indicates a situation which, if not avoided, may result in damage to the test
equipment or vehicle.

Example:

IMPORTANT:
Do not force the CompactFlash® card into the slot.

1.1.5 Procedures

>

An arrow icon indicates a procedure.

Example:

To change screen views:
1. Select View.
The drop-down menu displays.
2. Select an option from the menu.
The screen layout changes to the format you selected.



Using This Manual Additional Manuals

1.2 Additional Manuals

Tools that work in conjunction with various hardware and software modules have separate
manuals available for each of the modules.

1.3 Tool Help

Your unit has Tool Help containing reference and procedural information found in this and other
tool related user’s manuals. From the main menu, access Tool Help on the Utilities menu.



Introduction

The Scanner™ Plug-in (Figure 2-1) provides a direct communication link to the electronic control
modules (ECMs) on a vehicle and performs all of the standard functions of a scan tool.

Figure 2-1 MODIS™ Scanner™ Plug-in

The Scanner™ Plug-in provides extensive vehicle-specific engine, transmission, antilock brake
system (ABS) and airbag diagnostic trouble code (DTC) lists, functional tests, and troubleshooting
information. The Scanner™ Plug-in can display data from the vehicle in text or graphical mode.

2.1 Connections

1— Connector for the Scanner™ Plug-in data cable
2— Connector for the MODIS™ unit

Slides into the Scanner™ Plug-in connector inside the MODIS™ unit.
3— Scanner™ Plug-in slot

Figure 2-2 Top of the MODIS™ unit and Scanner™ Plug-in
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2.2 Technical Specifications

2.3

Dimensions:
Height:
linch
22 mm
Width:
3inches
75 mm
Depth:
6 inches
153 mm

Weight:
9.7 oz.
2759

Operating Temperature Range (ambient):

At 0 to 90% relative humidity (non-condensing)
32 to 104°F
0to 40°C

Storage Temperature (ambient):

At 0 to 70% relative humidity (non-condensing)
-4 to 122°F
—20 to 50°C

Cables

Technical Specifications

The included data cable (Figure 2-3) uses interchangeable vehicle adapters for connecting the
Scanner™ Plug-in to the diagnostic connectors of the test vehicle. Captive screws secure both

data cable ends. An optional data cable extension is available.

Figure 2-3 Data Cable



Introduction Power Supply

2.4 Power Supply

The MODIS™ unit can receive power from two sources when testing with the Scanner™ Plug-in:
= Vehicle power
= Battery pack power

We recommend that you use the rechargeable nickel-metal hydride battery pack as a backup
power source when testing.

Refer to your MODIS™ Display User Manual for more information.



Getting Started

The following steps get you started using the Scanner Plug-in:

1. Familiarize yourself with MODIS™ controls and connections.
2. Supply power to the scan tool
3. Press the Power button to turn the scan tool on

Refer to your MODIS™ Display User Manual for more information.

3.1 Demonstration Mode

The scan tool contains programs to demonstrate scan tool test capabilities without actually
connecting to a vehicle. Sample vehicle data with mock test results are provided to help you
become familiar with menus, navigation, and basic operations.

B To use the EOBD demonstration:
1. Highlight EOBD on the scan tool Main Menu and press Y/v'.

PR

Previous Vehicles
H 0BD Health Check
BMW
Citroen
- Fiat’Alfa/Lancia
Ford

a

Land Rover
Mercedes
MG/Rover
OpelVauxhall
Peugeot
Renault
) VW Audi
Seat/Skoda
Volvo
Honda/Nissan/Toyota

v v T T T wT T T T ww

1211907 | 10:35a B
Figure 3-1 Global OBD-II/EOBD menu selection

2. Press Y/v to open the EOBD database.
3. Highlight OBD Training Mode and press Y/v'.



Getting Started

3.2

No oM

8.
9.

Connecting to Vehicle Power

B |m| e olSl=

Global OBDII

Scroll to Select Diagnostic Mode
OBD Diagnose

OBD Training Mode

1 = 2 . 3 M= 4 =

(070209 | 08373, -]
Figure 3-2 Sample OBD Training Mode selection

Highlight Start Communication on the Main Menu OBD, and Press Y/ to select.
Press Y/v' when the vehicle connection message displays.

The ECU/Protocol Information screen displays, PressY/v’ to continue.

Highlight any of the item on the Select Service menu, and Press Y/v' to select.
Simulated test data now displays.

To exit, press N/X until you return to the Main Menu OBD.

Highlight End of Diagnose at the bottom of the list and press Y/v'.

10. Highlight the View button on the upper toolbar and press N/X to return to the Main Menu.

Connecting to Vehicle Power

You need the following to connect the scan tool unit to vehicle power:

= Data cable
= Test adapter
= Auxiliary power cables (optional, see below)

To connect to vehicle power:

1.
2.

4.

Connect one end of the data cable to the data cable connector on the top of the MODIS™.

Connect the other end of the data cable to the appropriate test adapter. The Scanner displays
relevant adapter and key usage for the identified vehicle.

Connect the test adapter to the vehicle diagnostic connector. The Scanner displays the
location of the diagnostic connector.

Turn the ignition on.

For vehicles that do not supply power through the diagnostic connector, you must use the auxiliary
power cables supplied with your MODIS™ unit.

For vehicles that do not supply power through the diagnostic connector, you must use the optional
auxiliary power cables.



Getting Started Connecting to a Computer

NOTE:
Do not plug the Lighter Power Cable into the DC power input port on the top of the unit. Vehicle
power must be supplied to the test adapter for the Scanner to communicate with the vehicle.

[E To use auxiliary power cables:
1. Connect the required test adapter to the data cable (Figure 3-3).

1— Lighter Power Cable, large end
2— Lighter Power Cable, small end
3— Vehicle test adapter

Figure 3-3 Auxiliary power cable connections

2. Plug the small end of the Lighter Power Cable into the port on the test adapter.
3. Plug the large end of the Lighter Power Cable into the socket of the Battery Power Cable.

4. Connect the clamps of the Battery Power Cable to the vehicle battery. Be sure to observe
correct polarity when connecting to the vehicle battery.

3.3 Connecting to a Computer

Connecting your scan tool to a computer for file sharing requires the use of the optional
ShopStream Connect™ software. ShopStream Connect is a free software program that can be
downloaded from the Internet at software.snapon.com.



Navigation

This section provides MODIS™ Scanner™ Plug-in software navigation information. For
information on general MODIS™ navigation, refer to the MODIS™ Display User’s Manual.

4.1 Screen Layout

A typical Scanner screen is comprised of an upper toolbar, a main body, and LED indicators
(Figure 4-1). Buttons and controls vary depending on the mode and stage of operation.

11— 68w | T ] P= [
Demonstration Vehicle
RPM 1984 TPS(%) 93 TPS(V)__0.04Ei
02 B1-S1 (mV) 903
02 B2-S1 (mV) 898
02 B1-S2 (mV) 950
2 —»02 B2-52 (mV) 937
INJ PW Bl (mS) 15.2
INJ PW B2 (mS) 15.1
ST TRIM-1(%) -2
LT TRIM-1(%) 12
ST TRIM-2(%) -2
LT TRIM-2 (%) 11
ST TRM AVG1 % 0E|J
3—> 1 2 = 2 - q |
1070109 | 11438 | o |

1— Upper toolbar
2— Main body
3— LED indicators
Figure 4-1 sample Scanner screen

4.1.1 Upper Toolbar

The upper toolbar (Figure 4-2 and Figure 4-3) controls vary depending on the mode and stage of
operations (Table 4-1).

|88 .. | @]

==

Figure 4-2 sample upper toolbar—Text view

Q%m Ijﬂ’_’_l.la\ml- I.@"“"‘"""Tl ga’ﬁw

Figure 4-3 sample upper toolbar—Graph view

10
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Table 4-1 upper toolbar controls

Screen Layout

Name Button Description

View Lets you change the way data displays

Pause ﬁ Stops data collection and lets you review the buffered data

Play ﬁ Continuously captures data and stores it in the Data Buffer

Clear Erases all data from the Data Buffer

Sort yidl8 Lets you select the order in which data displays

Review Lets you scroll through frames of paused or saved data

Scanner Indicates when the Scanner screen is active

Cursor Lets you make digital amplitude measurements of graph data

Z00m E Lets you change the magnification of the data in Graph View, or
pick the number of PIDs displayed on-screen in PID List view

Snapshot @ Lets you capture a snapshot using the PID Trigger or manual
Snapshot

Save g Lets you store scanned vehicle data or save the current screen
in memory

Print E Lets you print the displayed screen or a list of the current
parameter values
Offers a shortcuts to Custom Setup, Save Data and Custom
Data List. Custom Setup opens the Scanner Units dialog box,

e which lets you select how certain data values display. Save
Tools ==

Data opens the Save Data dialog box that lets you configure
how data is saved. Custom Data List lets you select which
parameters are displayed.

Scanner Button

When the Scanner button is selected, the background of the main body turns white, indicating that
Text view is active (Figure 4-4) and the up A and down ¥ arrows and the Y/v" and N/X buttons are

used for screen navigation.

11
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Screen Layout

68 | s ols=
Demonstration Vehicle
RPM 1984 TPS(%) 93 TPS(V) 0.04
02 B1-S1(mV) 903
02 B2-S1 (mV) 898
02 B1-S2 (mV) 950
02 B2-82 (mV) 937
INJ PW Bl (mS) 15.2
INJ PW B2 (mS) 15.1
ST TRIM-1(%) -2
LT TRIM-1(%) 12
ST TRIM-2(%) -2
LT TRIM-2 (%) 11
ST TRM AVG1l $ oEu
1~ 2 = 3 M= 4 ™ |

—  wow w0

Figure 4-4 Active Scanner screen

When you select a different button from the upper toolbar using the left € and right » arrows in
Text view, the background of the main body turns gray, indicating the screen is inactive
(Figure 4-5). See “Terminating Vehicle Communication” on page 22 for more information.

Figure 4-5 Inactive Scanner screen

Always exit Scanner mode before powering off. Exiting Scanner mode is different depending on
the view option selected.

IMPORTANT:

Exiting Scanner mode does not ensure that you have safely terminated communication with a
vehicle. See “Terminating Vehicle Communication” on page 22.

[E] To exit Scanner mode from text screens:
1. Use right» and left € arrows to scroll the highlight off of the Scanner button.
2. Press N/X to return to the main menu.

12



Navigation Making Selections

lEl To exit Scanner mode from PID List or Graphs views:
= Press N/X until you return to the main menu.

4.1.2 Main Body

The main body of the Scanner™ Plug-in screen provides prompts. The prompts guide you through
vehicle identification and task selection. Once communication is established with an ECM,
displays menus, parameter information, and tests.

4.1.3 LED Indicators

Four LED indicators appear at the bottom of the screen and show designated operating

conditions. The LEDs can be programmed to show change of state for certain digital parameters,
which vary by manufacturer.

4.2 Making Selections

Use the following procedures to navigate and make selections.

B To make selections:
1. Highlight a button or menu option.
2. Press Y/v to confirm the selection.

For more details, refer to the Navigation chapter in your MODIS™ Display User Manual.

13



5.1

Operations

This section explains general Scanner™ Plug-in operations and offers instructions for
customizing certain functions. The following is an outline of basic Scanner operation.

NOTE:
The sequence of steps may vary depending on manufacturer or model of the test vehicle. See the
manufacturer-specific vehicle communication software manuals for detailed procedures.

1. Selectthe manufacturer—Select and load the software database for the manufacturer of the
test vehicle. See “Selecting the Manufacturer” on page 14.

2. Identify the vehicle—lIldentify the test vehicle to the Scanner™ Plug-in by entering VIN
characters and answering questions. See “Identifying a Vehicle” on page 16.

3. Select the system—Enter the system to be tested (engine, transmission, ABS, etc.). See
“Selecting a System” on page 16.

4. Connect the Scanner™ Plug-in to the vehicle—Follow the on-screen connection
instructions to connect the Scanner™ Plug-in to the test vehicle. See “Connecting to a
Vehicle” on page 17.

5. Select the required test from the menu—Select tests for the vehicle you have identified.
See “Selecting from the System Main Menu” on page 18.

Selecting the Manufacturer

Vehicle manufacturers are organized into categories (Figure 5-1):

= Previous Vehicles—for recently tested vehicles

« Global OBDII—for any OBD-II/EOBD vehicle

= OBD Health Check—for any OBD-II/EOBD vehicle
= An alphabetical list of manufacturers

Previous vehicles provides a shortcut to a list of recently tested vehicles. Select to configure the
scan tool to any of the vehicles on the list.

Selecting Global OBDIl and OBD Health Check loads a software database that can be used to test
any OBD-II/EOBD compliant vehicle regardless of manufacturer.

14
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ey

canner
L. | Previous Vehicles
EOBD
H 0BD Health Check
Years
Citrogn 4 1992.2005
E Fiat/Alfa/Lancia r Heritage Software
Ford J
Land Rover »
Mercedes r
MG/Rover b
OpelVauxhall »
Peugeot 4
Renault »
L J VW/Audi 4
Seat'Skoda
Volvo
Honda/Nissan/Toyota

e i e

medular dir.gnestic infermation system

Selecting the Manufacturer

1— Scanner function
2— Scanner menu
3— Submenu

Figure 5-1 sample Scanner main menu software selection

lEI To select the manufacturer:
1. From the main menu, select Scanner.
The Scanner menu displays (Figure 5-1):
2. Select from the submenus as necessary.

The database loads, then a confirmation screen displays (Figure 5-2).

Boen | @) Jom] P
Global OBDII
»Generic OBDII/EOBD (29/04/09) X11

Figure 5-2 sample confirmation screen

3. Press Y/v to continue.

15



Operations Identifying a Vehicle

5.2 ldentifying a Vehicle

After you select the manufacturer, you are ready to identify the specific vehicle to be tested.

NOTE:
G] The exact procedure varies depending on the manufacturer. Screen prompts will guide you
through the procedure.

lEl To identify a vehicle:
1. Once the database loads, the first vehicle identification (ID) screen displays (Figure 5-3).

B |m| e olSl=

GM 1980-2008

_________ T E

Select Year (10th VIN)
9 - 2009

8 - 2008
7 - 2007
6 — 2006
5 - 2005
q
3
2
1

- 2004
- 2003
- 2002

- 2001 EJ

1~ 2 m= 3 M= 4 = |

070109 | 11:10a, ]

Figure 5-3 sample Vehicle ID screen

2. Pressthe up A and down ¥ arrows on the Thumb Pad until the correct character is shown,
then press Y/V.

3. Continue by entering VIN characters and pressing Y/v' or N/X to answer the on-screen
guestions as necessary.

Once the vehicle identification is complete, a Select System menu displays (Figure 5-4).

5.3 Selecting a System

You must select the vehicle control system you wish to test (Figure 5-4).

16



Operations Connecting to a Vehicle

o | o] =5 =
Demonstration Vehicle
Select System:
Engine
Transmission
Antilock Brakes
Airbag
Transfer Case
BCM
IPC
i1/ 2 = 3 - 4 =
J070109 | 11:11a, o]

Figure 5-4 sample system selection menu

B To select a system:
1. Pressthe up A and down ¥ arrows so the cursor is at the system you wish to test.
2. Press Y/v to select.

5.4 Connecting to a Vehicle

Connection instructions prompt you to connect the Scanner Plug-in to a vehicle diagnostic
connector for testing (Figure 5-5). See the appropriate Vehicle Communication Software manual
for details on connecting to a vehicle.

8. | )

o] =5 =

Demonstration Vehicle

Connect: OBD-II Adapter, no key
required.

Location: 16 pin connector under left
side of dash.

Press Y: Continue, Press N: Exit

1 = 2 = 3 M= 4 =

070109 | 11:10a, ]

Figure 5-5 Sample connection instruction screen

17



Operations Selecting from the System Main Menu

5.5 Selecting from the System Main Menu

Depending on the vehicle, a number of options may be available on the system main menu
(Figure 5-6).

B |m| e olSl=

Demonstration Vehicle

Main Menu (Engine)

»Data Display
Codes Menu
Functional Tests
Generic Functions
Troubleshooter

G1747

Figure 5-6 Sample system main menu

5.6 Using the Scanner Functions

System main menu options vary by make and model and may include the following:
= Data Display— displays data parameter information from the vehicle control module.
selecting may open a submenu of viewing options.

= Codes Menu—displays diagnostic trouble code (DTC) records from the vehicle control
module. selecting may open a submenu of viewing options.

= Service Codes—performs self-tests and displays codes after performing these tests.

= Functional Tests—provides specific subsystem and component tests. The tests vary
depending on the manufacturer and model.

= Actuator Tests—similar to functional tests, these tests check the operation of certain
actuators, such as solenoid valves and relays.

= System Tests—provides specific subsystem testing.
= Generic Functions—lets you access Generic OBD-II functions (1996 and later vehicles).

5.6.1 Data Display

Selecting Data Display on the system Main Menu has one of the following results:

= A submenu of data viewing choices displays.
= \Vehicle data displays.

A submenu displays if more than one data viewing mode is available for the vehicle (Figure 5-7).
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8. | )

Jom] P

Demonstration Vehicle

Data Menu
»ENGINE DATA 1
MISFIRE DATA
EGR, EVAP, ACC

SENSOR DATA

Figure 5-7 Sample Data Display submenu

On some models, the engine must be started or cranked before data can be displayed. For these
models, a “Waiting to Communicate” message displays if the engine was not cranked or started.

Once a selection is made, vehicle data displays (Figure 5-8).

S | @] olgl=
Demonstration Vehicle
RPM 1984 TPS(%) 93 TPS(V)__0.04E1
02 B1-S1 (mV) 903
02 B2-S1 (mV) 898
02 B1-S2 (mV) 950
02 B2-82 (mV) 937
INJ PW Bl (mS) 15.2
INJ PW B2 (mS) 15.1
ST TRIM-1(%) -2
LT TRIM-1(%) 12
ST TRIM-2(%) -2
LT TRIM-2 (%) 11
ST TRM AVG1 % 0E|J
1~ 2 = 3 M= 4 = ||

Figure 5-8 sample vehicle data screen

5.6.2 Codes Menu

Selecting Codes Menu from the system main menu opens a list of diagnostic trouble code (DTC)
viewing options (Figure 5-9). Selections typically include:

Trouble Codes

Clear Codes

Freeze Frame/Failure Records
DTC Status
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Demonstration Vehicle

GM Codes Menu

»Trouble Codes
Clear Codes
Freeze Frame/Failure Records
DTC Status

Figure 5-9 Sample Codes Menu viewing options

Selecting Trouble Codes typically opens a menu of viewing options. Select from the list to view
DTC data (Figure 5-10).

Clear Codes

8 | ]

olel=

Demonstration Vehicle

Engine Codes Menu

History Codes

Failed This Ignition

MIL SVS or Message Requested
Last Test Failed

Test Failed Since Code Cleared

»Engine/Trans Trouble Code Information

Figure 5-10 sample Trouble Codes menu screen

Selecting Clear Codes erases any DTCs that are stored in the selected control module of the
vehicle. Once the DTCs are erased, a confirmation message displays.

Freeze Frame/Failure Records

Freeze Frame/Failure Records allows you to view emissions related DTCs that caused the
malfunction indicator lamp (MIL) to turn on, and parameter data that was recorded at the time the

DTC set.
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lEI To view freeze frame/failure records:
1. Select Freeze Frame/Failure Records from the Codes Menu.
The DTC that turned the MIL on displays (Figure 5-11).

o olge

GM 1980-2008

P0109 MAP or BARO Pressure Circuit
Intermittent

Figure 5-11 Sample Freeze Frame/Failure Records DTC display

2. Press Y/v to view the recorded data, which displays similar to live data.
3. Press N/X once to open the Exit menu.
4. Press N/X twice to return to the Codes Menu.

DTC Status

DTC Status allows you to view the condition of any available DTC. For example, a DTC whose
setting conditions occurred once but must occur twice before the code actually sets would display
as a pending code.

[E To view DTC status:
1. Select DTC Status from the Codes Menu.
The DTC selection screen displays (Figure 5-12).

.- | @] o =

Demonstration Vehicle

DTC Status
Scroll In Desired Trouble Code To Test
*E % Pulgg *% %

N

Figure 5-12 sample DTC Status selection screen
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Press the up A or down ¥ arrows until the first selectable character of the DTC displays.
Press Y/v' to confirm that character and advance to the next selectable position.

Repeat Steps 2 and 3 until the complete DTC displays.

Press Y/v' to view the status.

5.6.3 Functional Tests

The Functional Tests selection on the Scanner main menu is used to access vehicle-specific
subsystem and component tests. Available tests vary by manufacturer, year, and model. Refer to
the appropriate Vehicle Communication Software manual for information on conducting functional
tests and test availability.

There are four general types of functional test operation:

Information Tests—are read-only tests, like selecting VIN from a Functional Tests menu to
display the VIN of the identified vehicle.

Toggle Tests—switch a component, such as a solenoid, relay, or switch, between two
operating states. The terms “on/off,” “open/clsd” (open/closed),” “enab/disa” (enable/disable),
and others may be used to identify the different states.

Variable Control Tests—command a certain value for a system or component, such as
varying the spark timing in increments of one degree (1°) or varying the duty cycle of the EGR
valve in increments of 10%.

Reset Tests—reset the adaptive, or learned, values that are stored in the control module.

5.6.4 Terminating Vehicle Communication

Once you have established communication with a vehicle, you must terminate communication
with the vehicle control module in order to safely shut down the Scanner Plug-in. Use the following
procedures to terminate correctly.

IMPORTANT:
Damage to the vehicle may occur if communication is abruptly terminated.

B To terminate communication from a manufacturer or Global OBD-Il database:
* Press N/X until you reach the main menu (Figure 5-13).
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o e olSl=

Demonstration Vehicle

Main Menu (Engine)
»Data Display
Codes Menu
Functional Tests
Generic Functions
Troubleshooter

G1747

Figure 5-13 sample system main menu

A “stopping communication” message appears briefly before the main menu displays.

5.6.5 Exiting Scanner Mode

Always exit Scanner mode before powering off. Exiting Scanner mode is different depending on
the view option selected.

IMPORTANT:

Exiting Scanner mode does not ensure that you have safely terminated communication with a
vehicle. See “Terminating Vehicle Communication” on page 22.

lEI To exit Scanner mode from text screens:

1. Use right» and left € arrows to scroll the highlight off of the Scanner button.
2. Press N/X.

You are returned to the main menu.

B To exit Scanner mode from PID List or Graphs views:
= Press N/X until you return to the main menu.

5.7 Viewing Data Graphically

The Scanner provides multiple options for viewing and managing data.

5.7.1 Changing Screen Views

The View button on the upper toolbar lets you change how data displays (Figure 5-14).
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B To change screen views:
1. Select the View button.

A dropdown menu displays (Figure 5-14).

Figure 5-14 Sample View menu

2. Select an option from the menu and the screen layout changes to the selected format.

PID List View

The PID List view displays all parameters in a table format. As many as sixteen parameters
(Figure 5-15) can be viewed on one screen depending on the zoom setting.

BB 0= [ C |

olS =

RPM

1480

TPS(%)

TPS(V)

0.00

02 B1-51(mV)

187

02 B2-51(mV)

625

02 B1-52(mV)

781

02 B2-52(mV)

790

INJ PW B1(mS)

138

INJ PW B2(mS)

138

ST TRIM-1(%)

LT TRIM-1(%)

ST TRIM-2(%)

LT TRIM2(%)

ST TRM AVG1 %

LT TRM AVG1 %

ST TRM AVG2 %

Figure 5-15 Sample PID List view
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lEI To adjust the Zoom setting:
1. Select the Zoom button on the upper toolbar.
The Zoom dropdown menu displays (Figure 5-16).

Viewing Data Graphically

%avwlﬁ$m |j§l&;m--_

Jum] PSS

2 PlDs

RPM

4 PIDs

1529

TPS(%)

8 PIDs

0

TOCAN

T

Figure 5-16 Sample Zoom dropdown menu

2. Highlight a menu item and press Y/v'.
The menu closes and the display changes to show the selected number of PIDs.

Reviewing PIDs

You can review collected PID data by pausing the screen (Figure 5-17). Once data collection is
paused, all of the data being held in the buffer can be reviewed.

1— Pause/Play button

2

//

%ml@mw |EM Q_E-Wﬂ‘.— I

P i ===
L] u L

RPM

1480

TPS(%)

0

2— Review button

3— Parameter data
Figure 5-17 Sample paused upper toolbar in PID List view

lEI To review collected parameter data:
1. Select the Pause button to stop the data collection.
2. Select the Review button and use the thumb pad arrows to scroll through the data.
Right » moves you backward one frame at a time.

a.
b.
c.

3. Press N/X to release the Data Review control.
4. Select the Play button to unfreeze the screen.

Left €4 moves you forward one frame at a time.

Up A moves you forward, and the rate at which you move through the data accelerates if
the button is held down.
Down ¥ moves you backward, and the rate at which you move through the data
accelerates if the button is held down.

Clearing the Buffer

The Clear button on the toolbar erases all of the data in the buffer.
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To clear the data buffer:
1. Select Clear on the upper toolbar.
A confirmation screen displays.
2. Press Y/v to erase the data, N/X to cancel.
New data begins saving after the buffer has been cleared.

Sorting the PID List
The Sort button on the toolbar allows you to arrange the parameter list three ways:
= Factory Sort—in the order transmitted by the electronic control module (ECM)

= A-Z Sort—in alphabetical ascending order
= Z-A Sort—in alphabetical descending order

To sort the PID List:
1. Select the Sort button on the upper toolbar.
2. Highlight an option on the drop-down menu.

BB | 00| ®ccn f53 = Jom] =3 12
Factory Sort

BAEEREO: ml Fa) I!E ZA Son E; :;; -

Figure 5-18 sample sort drop-down menu

3. Press Y/v to sort.

NOTE:
Any PIDs that were locked are unlocked whenever a selection is made from the Sort button.

Locking Parameters

You can lock parameters in place for customized list viewing.

To lock a parameter:
1. From the upper toolbar, press the down ¥ arrow.
2. Select the parameter you want to lock.

The parameter menu displays (Figure 5-19).

&8"“”'[ B ciean | EM QZW 16 I Q]Ejﬁ
RPM 1924 =
TPS(%) a7
TPS(Y) 351

911
Unlock A1l [1{mV) 594

Figure 5-19 Sample parameter menu

3. Select Lock.
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A lock icon displays to the left of the parameter name (Figure 5-20) and the locked parameter
stays in place when your scroll through the list.

B || e | 8] Qo e | Jm] P=T)
RPM 1963 - :’l
TPS(%) 0
TPS(V) 0.00

Figure 5-20 Locked PID sample

4. Repeat the above steps to lock multiple parameters.
5. Press N/X to return to the upper toolbar.

[E To unlock parameters:
1. Select a locked parameter and when the parameter menu displays, select Unlock.
The lock icon disappears and the parameter can be scrolled as before.
2. Press N/X to return to the upper toolbar.

[E To unlock all the parameters at once, do one of the following:
= Select a locked parameter and when the parameter menu displays, select Unlock All.
* Select any option from the Zoom menu.

Text View

Text view displays parameters as plain text (Figure 5-21).

&= | @] ] P= [
Demonstration Vehicle

RPM 1984 TPS(%) 93 TPS(V)__0.0agi
02 B1-S1 (mV) 903
02 B2-S1 (mV) 898
02 B1-S2 (mV) 950
02 B2-82 (mV) 937
INJ PW Bl (mS) 15.2
INJ PW B2 (mS) 15.1
ST TRIM-1(%) -2
LT TRIM-1(%) 12
ST TRIM-2(%) -2
LT TRIM-2 (%) 11

ST TRM AVGl % OEiJ

1~ 2 = 3 M= 4 = |

07108 | 11:43a | o |

Figure 5-21 sample Text view
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Graph View

The Graph view let you view data in line graph format (Figure 5-22). You can view two, four, six,
or eight graphs at a time depending on the option selected from the VIEW menu.

N0 3] Qe | Bmrer] EEE

i :m‘ IL S Ls"ﬁ": J ,“ J'L."ﬂ, —\ ) ;"IL \, A mj
m R ARI RN
S R

O

i

1— Maximum value of captured data
2— Current value
3— Minimum value of captured data
Figure 5-22 sample Graph screen

Parameter Menu

When viewing data in the Graph view, the scan tool offers a parameter menu (Figure 5-23) with
the following options.

= Lock—lets you lock a parameter into position to compare readings.
= Unlock—Ilets you unlock a single parameter.
= Unlock All—lets you unlock all locked parameters.

= Auto Scale—lets you automatically rescale the minimum and maximum values of the
selected graph captured within the last 2000 points.

= Manual Scale—lets you scale minimum and maximum values of the selected graph.
= Scale All—lets you scale the minimum and maximum values of all the graphs.

= Set Trigger Levels—Ilets you specify automatic screen-pausing conditions when Snapshot >
PID Trigger is used.

= Clear Trigger Levels—lets you remove set trigger conditions from the selected parameter.

= Clear All Trigger Levels—lets you remove set trigger conditions from all parameters
simultaneously.

E] To lock a parameter:
1. From the upper toolbar, press the down ¥ arrow.
The highlight moves to the first parameter graph.
2. Select the parameter you want to lock.
The parameter menu displays (Figure 5-23).
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Figure 5-23 sample parameter menu

3. Select Lock.
A lock icon displays and that graph does not move when you scroll the data (Figure 5-24).

) e 7 [ s [ =Y

.25

0.57

R R,

Figure 5-24 Lock icon indicating a locked parameter

0. 00

4. Scroll other parameters into place to compare readings.

B To unlock a parameter:
1. Select the locked parameter to open the parameter menu (Figure 5-25).

Clesr All Trigger Levels

Figure 5-25 sample parameter menu

2. Select Unlock.
The lock icon disappears and the parameter can be scrolled as before.

B To unlock all parameters:
1. When a parameter is locked on-screen, select any parameter.
The parameter menu displays (Figure 5-26).

B | W Dcenn | B | Qoo | Bovrwer| J=TF=I|

""‘f Yl Iy H \i L

Scale Al
Set. Trigger Levels
Clear Trigger Levels —_—
Clesr All Trigger Levels

Figure 5-26 Sample parameter menu
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Select Unlock All.
All of the locked icons disappear and all of the parameters can be scrolled as before.

B To automatically scale a parameter:

1.

2.

Select a parameter.
The parameter menu displays (Figure 5-27).

o [ R S - oy olgl=l

Scale Al
Set. Trigger Levels
Clear Trigger Lewels
Clewr All Trigger Levels ||

Figure 5-27 Sample parameter menu

Select Auto Scale.
The minimum and maximum graph values are reset.

lEI To manually scale a parameter:

1.
2.

© N O~ W

Select a parameter to open the parameter menu.
Select Manual Scale.

A line displays across the top of the graph along with a box that displays the maximum
recorded value (Figure 5-28).

B8 | | e | 58] | Qeoo | Brssrmecr | [/ =)

WO T v

Figure 5-28 sample manually scaling a parameter

IT[N

Use the down ¥ arrow to move the maximum displayed value into position.
Press Y/v to set the selected value.

Press Y/v to scale the minimum value.

Use the up A arrow to move the maximum displayed value into position.
Press Y/v to set the selected value.

Press N/X to exit manual scale.

The top and bottom of the graph is now clipped so that only the portion that falls between the
selected minimum and maximum values displays.

[E To scale all parameters

1.

Select a parameter.

The parameter menu displays.

Select Scale All.

The minimum and maximum graph values are reset for all of the parameters.
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lEI To set trigger levels:

1. Select a parameter.
The parameter menu displays (Figure 5-29).
= T "| A A
Auto Scale '|| “I \ |
s S L LJ L U H NATRREINE
S |‘-.I Wil I w1 ‘ n AL AT I nJ] I nJ
Figure 5-29 sample parameter menu
2. Select Set Trigger Levels.
The active trigger level line displays as a solid black line together with an on-screen position
value (Figure 5-30).
= 5 ’]j _____ \ [| T|_ __[-T[-‘ [II
0. 00 II|_|| | l"P ‘ | T| |_.i Ll L |
Figure 5-30 sample active trigger line
An upper and lower trigger level must be set.
3. Setthe upper trigger level using the up A and down ¥ arrows to place the trigger level line on
the PID graph, and press Y/v.
When set, the solid black line changes to a dotted line (Figure 5-31).
@G_WW.I%;JE}\JMIM ] =)
t4.25 A I
0 57 T ['I [ 1 \ ‘ 1 1 \J 1 |_|
e ULV LL|J_IL'J|_JLJU
Figure 5-31 sample set trigger levels
4. Set the lower trigger level using the up A and down ¥ arrows and press Y/v'.
The area between the two trigger levels establishes the triggering condition. Any data points
that register outside of your set condition trigger the on-screen graphing to freeze.
5. Press Y/v if you want to switch between trigger level lines during the setting process.
6. When you finish setting your trigger level, press N/X.
NOTE:

Only three parameters can have trigger levels set at one time, but only one of the conditions needs
to be satisfied for triggering to occur.
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lEI To arm PID Triggering:
= From the upper toolbar, select Shapshot > PID Trigger.

A check mark displays next to the menu option (Figure 5-32).

B B[S [B]_[Qomre [ Qlalﬂ

=0 1| Manual

Figure 5-32 sample armed triggering

Trigger Delay

Once the trigger is detected, a collecting snapshot dialog box displays (Figure 5-33) and data after
the trigger detection begins to collect.

Collecting snapshot.
Please wait...

Press "Y' to stop
collecting data now.

[ [ 1]

Figure 5-33 sample collecting snapshot dialog box

The amount of data collected is specified by the % After Trigger setting, found in Utilities > Tool
Setup > Save Data. You can manually stop the snapshot by pressing Y/v" at any time during the
data collection.

Once data collection is finished, graphing automatically stops and the screen changes as follows
(Figure 5-34):

mqaywwwqpmhimgﬁwx

[ UL I W | I i UL ; % L

“MiMﬂﬁU~”mUiJumu
LR I UL

l|
a0 350 0 250 200 IS0 ol

JM

Figure 5-34 sample PID Triggering condition setting(s) met

= The Play button replaces the Pause button on the upper toolbar.
= A frame counter, showing the trigger point, displays on the buffer bar.
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= A vertical line displays at the point where the trigger was detected on all of the parameter
graphs. A different color is used for vertical line on the graph of the parameter that set the
trigger, which makes it is easy to determine what condition caused the event.

NOTE:
When the Play button is selected to resume data collection the red and green trigger detection
lines turn gray to indicate data collection was stopped at this point.

To restart graphing:
= Select the Play button (Figure 5-34).

To clear trigger levels:
1. Select a parameter.
The parameter menu displays (Figure 5-35).

Lock

nlock-All fig !

Anto Scale L Mo 1 i

‘ e Y | —— T A
Seale AL L

et Toggerlarels

e | (o 1L A0 W N0 AT o 10T

Figure 5-35 Sample parameter menu

2. Select a Clear option.
— Clear Trigger Levels—removes the trigger settings from the selected parameter.
— Clear All Trigger Levels—removes the trigger settings from all of the parameters.

To disarm PID Triggering:
= From the upper toolbar, select Snapshot > PID Trigger.
The check mark next to the menu option disappears (Figure 5-36).

88w (D] Scen (8] [ Qe [Brers Qlajﬂ

Figure 5-36 Sample armed triggering

5.7.2 Pausing Data

The Pause button temporarily stops, or “pauses”, data collection when viewing parameter data in
the PID List or Graph views (Figure 5-37).

68 e (DN neme | 58] 2] Qe | Brrmecr| o
] Dol —151@1

Figure 5-37 Pause button viewing “live-screen” data
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When the Pause button is selected, it changes to the Play button, which resumes data collection.
A frame counter now displays on the buffer bar. Select Play to resume viewing live data and a gray
vertical line now appears on the graphs at the point where the data collection was paused.

The Review button on the toolbar becomes active when data collection is paused and the position
indicator located just below the toolbar displays. The Review button allows you to scroll through
and review frames of data.

[E To review paused data:
1. Select the Review button.
The Review button changes color to indicate it is selected (Figure 5-38).

=~

Figure 5-38 Sample active Review button
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i
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2. Navigate through the paused data using the up A, down V¥, right », and left € arrows on the
thumb pad:

a. Up A moves you forward one frame at a time.
b. Down ¥ moves you backward one frame at a time.
c. Right » moves you backward one screen at a time.
d. Left €4 moves you forward one screen at a time.
Scroll option are also available for reviewing the data.
3. With the Review button active, press Y/v' to change scroll options.
The Scroll options dropdown menu displays (Figure 5-39).

B8 | Ty, 98] 1] Quicomnie || jm] 1Y
[ ——

Figure 5-39 sample Scroll options menu

The following choices are available:

— Manual Scroll—use the up A and down ¥ arrows to move through the data, this is the
default setting.

— Auto Scroll Fast—automatically advances the data in a continuos loop at normal speed.
This is the recording speed, which is the transmission speed of the ECM.

— Auto Scroll Slow—automatically advances the data in a continuos loop at half speed.
4. Press N/X to deactivate the Review button.

5.7.3 Clearing the Buffer

The Clear button on the toolbar erases all of the data in the buffer. A confirmation screen displays
when the clear button is selected.

New data begins saving after the buffer has been cleared.
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5.7.4 Sorting the PID List

The Sort button on the toolbar allows you to arrange the parameter list three ways:

= Factory Sort—in the order transmitted by the electronic control module (ECM)
= A-Z Sort—in alphabetical ascending order
e Z-A Sort—in alphabetical descending order

[E To sort the PID List:
1. Select the Sort button on the upper toolbar.
2. Highlight an option on the drop-down menu (Figure 5-40).

B || ®ac [ Qo =] =)=
[ BAROY) ] 7o [a.78 IZI
| BAROKPa) N

Z-A Son I 700

Figure 5-40 sample sort drop-down menu

3. Press Y/v to sort.

NOTE:
Any locked parameters are unlocked whenever a selection is made from the Sort button.

5.7.5 Using Cursors

When data is paused in Graph view, the Cursor button displays on the upper toolbar
(Figure 5-41), which allows you to view digital amplitude measurements of frozen data.
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Figure 5-41 sample frozen screen with Cursors active

35



Operations

Saving Captured Data

lEI To use the Cursor:

1.
2.

Select the Pause button.
Select the Cursor button.

Cursor lines display on the frozen data (Figure 5-41). The value where the cursor line
intersects the frozen data displays above the cursor line.

Press the left « and right » arrows to move the cursor.
Press N/X to exit the Cursor mode.

5.7.6 Using Zoom

The Zoom button lets you choose the number of PIDs that display on-screen when used in the
PID List view and lets you choose different levels of magnification when used in the Graph view
(Figure 5-42).

o [ P Y [ olele]
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Figure 5-42 sample Graph ZOOM options

When viewing paused data, a Zoom Out selection is available on the drop-down menu
(Figure 5-43). Select Zoom Out and all of the data in the buffer displays on the graphs.
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Figure 5-43 sample ZOOM options on paused data
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5.8 Saving Captured Data

The scan tool provides multiple options for saving and reviewing captured data:

= Save Frame—This feature allows you to save up to 512 frames of buffered data (data held in

scan tool memory) for each parameter. Pages can be saved from the Text, PID, and Graph
views, but can only be replayed in the Graph view.

Save Movie—This feature allows you to save up to 2000 frames of data (buffered data plus
data transmitted after triggering) for each available parameter. Files can be saved from the
Text, PID, and Graph views, but can only be replayed in the Graph view.

Save Image—This feature allows you to capture a single screen as an image. Image files can
be opened with common computer programs, such as Microsoft Paint.
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lEI To save a frame:

1. Select the Save button from the toolbar.
A dropdown menu of choices displays (Figure 5-44).

ﬁﬂmlﬁ"m |jt‘d__lq=owm I@m"l

1 Save Frame
Save Image

| rPM
ftaz7 | A A A A

Figure 5-44 save button menu

2. Select Save Frame from the menu.

The Setup Saved Data Notation dialog box displays.
3. Use the dropdown lists to enter vehicle information.
4. Select Save to close the dialog box.

5. A ‘“saving scanner data” message displays while the file is being saved. Once the message
clears, the file is ready for reviewing.

B To review a Save Frame file:
1. Select the Saved Data button from the main menu.
2. Select the Data Management option (Figure 5-3).

A = e e

modular diagnostic information system

L 1211907 | 10:39a | B
Figure 5-45 Data Management Menu Option

A list of all saved files displays.
3. Select the file that you would like to review.

NOTE:
G] Frame files are saved with a SC(S) file type designation.

[E To save a movie file:
1. Select the Save button from the toolbar.
A dropdown menu of choices displays (Figure 5-44).
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2. Select Save Movie from the menu.
The Setup Saved Data Notation dialog box displays (Figure 5-46).

Save "A::; Year Make Component Condition E':::;gs
| 53 ”Izum [ Chevrolet I 02 Sensor [ Good I
Add Additional Inf ion (7 lines il Press ESC when finished.

Vehicle: 2001 CHEVROLET TAHOE 4WDEngine: 5.3L V8 VORTEC SFI;Engine

Figure 5-46 Sample Saved data dialog box

3. Use the dropdown lists to enter vehicle information.
4. Select Save.

A “saving scanner data” message displays while the file is being saved. Once the message
clears, the file is ready for reviewing.

[E To review a movie file:
1. Select the Saved Data button from the main menu.
2. Select the Data Management option (Figure 5-3).
A list of all saved files displays.
3. Select the file that you would like to review (Figure 5-47).

NOTE:
All movie files are saved with a SC(M) file type designation.

4. Select the Review button to set the data viewing speed.

E] To save an image file:
1. Select the Save button from the toolbar.
A dropdown menu of choices displays (Figure 5-44).
2. Select Save Image from the menu.
The Saving screen image....message displays.

lEl To review a Bitmap file:
1. Select the Saved Data button from the main menu.
2. Select the Data Management option (Figure 5-3).
3. Alist of all saved files displays.
4. Select the file that you would like to review.

NOTE:
Image files are saved with either a BMP or JPG file type designation.
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5.9 Viewing Saved Data

Use the Save Data button to access the Data Management screen option. Data Management
allows you to access and manage all of the files you have saved (Figure 5-47).

AN

&m'r Emr:l Eccn-vl QMI’EMCTMLIEW éw

2 e L2 0% i L

Type Size | Date/Time Year | Make Component Condition | =

% 04,10 (0

1 SSCM)  0.1% 040609 14:44 User(01_90406...

$JPEG 0.1% 040609 14:40 User006_90406...

SJPEG 0.1% 040109 11:54 UserD5_90401...

$JPEG  0.1% 04/01/09 11:53 User004_90401...

SJPEG  0.1% 0401109 11:53 User03_90401...

SJPEG  0.1% 040109 11:53 User02_90401... —

S JPEG  0.1% 040100 09:47 User01_90401...

4 GB(M) 0.1% 040109 09:10 User0l02_90401...

$GB(S) 0.1% 033109 17:18 UserdD1_90401...

$GBM) 0.1% 033109 17:18 User001_90401...

SBMP  0.1% 0373109 16:55 User10_90401...

SBMP  0.1% 03727709 13:07 User09_90327...

SBMP  0.1% 032709 13:06 User08_90327... .

BMP 0.1% 0327709 13:06 User007_90327... ;I

1— Saved data files
The saved files available depend on the destination selected in the Setup menu.
2— Saved data location indicators
Displays where files are saved; a CF card, internal memory, or a USB storage device.
3— LOAD button
Opens the saved file selected.
4— EDIT button

This function opens the Setup Saved Data Notation dialog box and allows you to add year,
make, component, and condition information to the file.

5— DELETE button

Erases the saved file(s) from storage memory.
6— COPY button

Lets you copy the selected file(s) from one CF slot to the other.
7— MOVE button

Lets you move the selected file(s) from one CF slot to the other.
8— SELECT ALL button

Selects all files.
9— Info (information) button

Displays the number of files saved and the amount of memory used and available.
10—SETUP button

Lets you set the location where files are saved.
11—Memory indicator

Displays the amount of CF card memory available.

Figure 5-47 Sample Data Management screen
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5.9.1 Identifying Saved Files

Saved files have the following characteristics:

= Type identifies the kind of saved data file:
— SC(M)—movie file of up to 2000 data points saved using the Save Movie toolbar option.
— SC(S)—frame file of up to 2000 data points saved using the Save Frame toolbar option.

— SC(P)—snapshot file of one data stream transmission saved using the Snapshot button
on the toolbar.

— BMP—screen image saved using the Brightness/Contrast button. The button is set to
Save Image with BMP (bitmap) selected as the File Type in the Save Data dialog box.

— JPG—screen image saved using the Brightness/Contrast button. The button is set to
Save Image and JPEG is selected as the File Type in the Save Data dialog box.

— SPS—designates bitmap files saved prior to the 7.2 software update.
= Size is the percentage of available storage space used.
= Date/Time is the date and time that the data was saved.
= Year is the vehicle model year.
= Make is the vehicle manufacturer.
= Component is the component tested.
= Condition is for good, bad, or unknown status options.

[E To exit the Data Management screen:
e Press N/X.

5.9.2 Loading Saved Files

The Load button lets you review saved screen data and print the screen.

[E To load data:
1.

Select Save Data > Data Management.
The Data Management screen displays.
2. Select afile from the list.
3. Select Load from the upper toolbar.

B To exit the loaded screen:
1. Press N/X to return to the Data Management screen.
2. Press N/X again to return to the main menu.

5.9.3 Editing Saved Data

The Edit button opens the Edit Saved Data Notation dialog box (Figure 5-48).
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Edit Saved Data Notation

Add Keep
Save pNgre Year Make Component Condition Eptries
| 2 J|| 2001 l Chevrolet 02 Sensor | Good I
Add Additional Inf ion (7 lines il ). Press ESC when finished.

Vehicle: 2001 CHEVROLET TAHOE 4WDFEngine: 5.3L VB VORTEC SFi;Engine

Figure 5-48 sample Edit Saved Data Notation dialog box

B To edit saved data:
1. Select Edit to open the Edit Saved Data Notation dialog box.
2. Use the dropdown lists to edit the file information.
3. Press N/X to exit.

5.9.4 Reviewing Saved Data
The Review button is used to review movie data files. There are two ways to review data files:

= Manually
= Automatically

Auto Scroll Fast [ E
|

iulo S:nll_sww v' A A A i
Figure 5-49 save data review options

B To manually review data files:
1. Select the Review button.
2. Use the Thumb Pad arrows to navigate through the data.
a. Up A moves you forward one frame at a time.
b. Down ¥ moves you backward one frame at a time.
c. Right » moves you forward one screen.
d. Left 4 moves you backward one screen.

lEI To automatically scroll data files:
1. Select the Review button.
2. Press Y/v again to display the menu of scroll options.
3. From the Review menu, select an Auto option.
— Auto Scroll Fast automatically scrolls the data at full-speed.
— Auto Scroll Slow automatically scrolls the data at half-speed.
4. Press N/X to close the menu.
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5.9.5 Deleting Saved Files

>

The Delete button lets you remove saved files from memory.

NOTE:
Factory-installed files cannot be deleted.

To delete files:
1. Select Save Data > Data Management.
2. Select a file from the list.
3. Select Delete from the upper toolbar.
A confirmation message displays (Figure 5-50).

Figure 5-50 sample delete file confirmation message

4. To permanently remove the data from memory, press Y/v/, or press N/X to keep the data and
close the dialog box.

After processing your delete request, you are returned to the Data Management screen.

5.9.6 Copying and Moving Saved Data

>

The Copy and Move functions let you transfer saved test data from one CF card to the other.

To copy or move data:

1. From the main menu, select Save Data > Data Management.
The Data Management screen displays.

2. From the upper toolbar, select Setup.
The Save Data dialog box displays.

3. Set Top CF as the Save To option and press N/X to close the dialog box.
The test data saved to the top CF displays.

4. Use the up A and down V¥ arrows to highlight a file from the list on-screen.

5. Use right » and left € arrows to select Copy or Move from the upper toolbar.
A confirmation message displays (Figure 5-51).

Selected entry has been copied
to target device.
Press "Y' to continue.

Figure 5-51 sample copy file confirmation message

6. Press Y/v to close the message box.
You return to the Data Management screen.
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NOTE:
Factory installed files can not be deleted, copied or moved.

5.9.7 Selecting All Files

Use Select All to highlight all files on-screen so you can delete, copy, or move the files as needed
(Figure 5-52).

| 2 I I B oxare I ﬁ cn-v-lig rCVE IE;I!H!!EIH!!IEﬂ s I Emerie
s (mf =l NN ENERR RN RR NN NNANARRENN

Component Condition
JPEG 1% 12/ UserDD8_90512...
JPEG L / 2 UserD07_90406...
SC(M) 0.4% User001_90406...
JPEG 1% 5.1 = UserDD6_90406...
JPEG 1% f User0D5_90401...

JPEG  0.1% i User004_90401...
JPEG / 90401...
JPEG

Figure 5-52 sample Select All screen

5.9.8 Viewing Saved Data Information

Selecting the Info button on the toolbar opens a window that provides detailed information about
the saved data files, such as the amount of storage memory used and the capacity of the memory
storage media (“Sample Info button window”). Only details for the selected “Save to” destination
display.

Files saved = 24
Files remaining = 476
Capacity = 500

Used space = 5MB
Free space = 239MB
Capacity = 244MB

Press (" to close.

Figure 5-53 sample Info button window

5.9.8 Setting a Destination for Saved Data

Use the Setup button on the upper toolbar to set the destination for saved files (Figure 5-54).

% After Trigger

My data

[Top CF
File Type
JPEG

Figure 5-54 sample Save Data dialog box
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lEI To change the destination for saved files:

1. Select Save Data > Data Management.
The Data Management screen displays.

2. Select the Setup button.
The Save Data dialog box displays (Figure 5-54).

3. Select an option from the My data dropdown menu.

4. Press N/X to confirm your selection and close the dialog box.
The box for the location you selected is checked (Figure 5-55).

&mr Em F\QGW hm Emmu.u. [ aw
o) O Ox [T

Type Size | Date/Time Year | Make Component Condition | =
P 1} 040609 00 0
$SCM)  0.1% 04/06/09 14:44 User001_90406...
JPEG _ 0.1% 04/06/09 14:40 User06_90406...

Figure 5-55 CF slot indicator checked

5.10 Print Button

The Print button is used to print what is displayed on the screen. The following printing options
may be available:

= Full Screen—print only what is visible on the screen.

= Full PID List—prints the entire list of parameters.

= Full Codes List—yprints the list of codes in vehicle memory when viewing codes.

lEI To print:

1. Verify that your printer and scan tool are set up properly for printing.
2. Select a print option from the dropdown menu (Figure 5-56).

8 | @ D _ 8 =

[ Full Screen
Full PID List

Full Codes List

Figure 5-56 sample Print menu

When printing begins, an “Initializing printer...” message displays. The message box closes
when printing is complete.

5.11 Tools Button

The Tools button on the upper toolbar provides a shortcut to commonly used scan tool
configuration settings (Figure 5-57).

44



Operations

Tools Button

Save Data
Custom Data List
LED Setup

Figure 5-57 sample Tools button menu

The following choices are available on a dropdown menu:

e Custom Setup

e Save Data

e Custom Data List
e LED Setup

NOTE:
The Custom Data List and LED Setup selections are only available when in the Text view mode,
these menu selections do not display when in Graph or PID List modes.

5.11.1 Custom Setup

>

Selecting Custom Setup opens the Scanner Units dialog box. Scanner Units is used to change
the units of measurement for certain parameters. You can choose between US Customary or
metric units of measure for available data parameters.

All measurement units return to their default values when the internal batteries are disconnected
or a different software database is selected.

Table 5-1 Units of measurement—defaults and options

Setting Default Option
Temperature degrees Celsius (°C) degrees Fahrenheit (°F)
Air Pressure (including . . “
manifold pressure) kilopascals (kPa) inches of mercury (“Hg)
Speed kilometers per hour (kph) | miles per hour (mph)
Other Pressures kilopascals (kPa) pounds per square inch (psi)

To change a setting:
1. On the upper toolbar, select Tool > Custom Setup.
The Scanner Units dialog box displays (Figure 5-58).

Scanner Units

Figure 5-58 Sample Scanner Units Menu
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2. Use right » and left € arrows to move between measurements, press Y/v' to open a
dropdown menu for the item to be changed.

3. Select the desired measurement and the dropdown closes.
4. Press N/X to confirm your selections and return to the Tools Setup menu.

5.11.2 Save Data

Selecting Save Data from the dropdown menu opens the Save Data dialog box, which allows you

to select where and how data is saved. Refer to “Setting a Destination for Saved Data” on page 43
for details.

5.11.3 Custom Data List

>

The Custom Data List selection, which is used to select specific data parameters to display, is
only available in the Text view mode. This allows you to focus on any suspicious or
symptom-specific data parameters and may allow for a faster display update rate.

Custom Data List selections are retained in the tool memory until a new vehicle ID is entered or
another vehicle control system is selected for testing.

NOTE:

If a parameter is not selected for display in the Custom Data List, it will not be displayed when you
enter Troubleshooter.

To select a custom data list:
1. From the upper toolbar, select Tools > Custom Data List.

The Data Selection screen displays. An asterisk (*) next to a parameter title indicates that
parameter is selected for display (Figure 5-59).

B |m| e olSl=

Demonstration Vehicle

Display Data
Select/Deselect All
*02 B1-S51(mV)

*02 B2-S1 (mV)

*02 B1-52 (mV)

*02 B2-S2 (mV)

*INJ PW B1(mS)

*INJ PW B2 (mS)

*ST TRIM-1(%)

*LT TRIM-1(%)

*ST TRIM-2(%) EJ

1~ 2 m= 3 M= 4 = |

070109 | 11:17a, -]
Figure 5-59 Sample Data Selection screen

46



Operations Tools Button
2. Select or deselect the desired parameters.

3. Select Display Data or press N/X to confirm your selections and return to the data display to
view the customized data list.

5.11.4 LED Setup

The LED Setup selection is used to program the operation of the four LEDs located just below the
main body of the Scanner screen. The LEDs switch on and off to reflect a change of state for the
assigned digital parameters. An LED turns red when switched on.

B To program LED operation:
1. On the upper toolbar, select Tools > LED Setup.
The LED assignment menu opens with LED 1 highlighted (Figure 5-60).

o e olSl=

Demonstration Vehicle

To change LED Assignment, Scroll Choice
And Press Y To Select. Press N To Exit.
1=Not Used
2=Not Used
3=Not Used
4=Not Used

1 = 2 . 3 M= 4 =

070109 | 11:13a

Figure 5-60 Sample LED assignment menu

2. Use the up A and down ¥ arrows to scroll through the list of available parameters.
3. Press Y/v tolock in a selection and move the highlight to the next LED.
4. Press N/X to close the menu and return to the data display once all the LEDs are assigned.
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This section covers potential maintenance issues for the Scanner™ Plug-in.

6.1 Removing the Scanner™ Plug-in

Your MODIS™ unit comes with the Scanner™ Plug-in installed. You should only need to remove
the Scanner™ Plug-in when it needs to be replaced.

[E To remove the Scanner™ Plug-in:
1. Exitthe SCANNER module.
2. Power off your MODIS™ unit.
3. Remove all cables and the battery pack.
4. Hold down the release tab (Figure 6-1) and slide out the Scanner™ Plug-in.

Figure 6-1 Release tab on back of the MODIS™ unit

6.2 Installing the Scanner™ Plug-in

Installing the Scanner™ Plug-in is only necessary when you have removed an outdated
Scanner™ Plug-in to replace it.

lEI To install the Scanner™ Plug-in:
1. Make sure that your MODIS™ unit is off.
2. Disconnect any external power adapters or cables.
3. Remove the MODIS™ battery pack.
4. Insert the Scanner™ Plug-in into its slot (Figure 6-2).
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Figure 6-2 Scanner™ Plug-in installation
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A.l

Troubleshooting

The following are solutions for problems that can occur while using the Scanner™ Plug-in.

No Communication Message

When the screen displays a “No Communication” (Figure A-1) message, it means the Scanner™
Plug-in and the vehicle control module cannot communicate with each other for some reason.
Common problems that prevent the scan tool from communicating with a vehicle are addressed
in this section. Manufacturer-specific problems are discussed in the applicable Vehicle
Communication Software manual.

o e olSl=

GM 1980-2008

No communication. Is key on? Ensure
Scanner is connected. Wait 15 seconds.

See Appendix B in the US Domestic
vehicle communication software manual.

Press N: Cancel

1 2 = 3 = 4 =
070109 | 11242, ]|

Figure A-1 sample “No Communication” message

The following conditions cause the Scanner™ Plug-in to display a “No Communication” message:

= The Scanner™ Plug-in is unable to establish a communication link with the vehicle.

= You are using the incorrect Personality Key with the test adapter.

= You selected a system for testing that the vehicle is not equipped with (for example, ABS).
= There is a loose connection.

= There is a blown vehicle fuse.

= There is a wiring fault on the vehicle.

= Incorrect vehicle identification was entered.
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A2

Using Legacy Software

Using Legacy Software

Occasionally, you may be unable to communicate with a particular vehicle because it is an older
model or for some other reason it is not covered in the current database. Legacy Software also
provides an alternate method of connecting to a vehicle when communication problems are
encountered. The Legacy Software runs your scan tool using an obsolete version of the operating
system software.

The Legacy Software option is available from the Utilities button on the MODIS™ main menu
(Figure A-2). Scroll through the dropdown menus, then press Y/v' to load the software.

S e e
modular diagnestic information system
H Utilities
Tool Setup »
Gas Bench Setup »
E System Tools »
Legacy Software » = | egacy Software
HDS Units H US Domestic
@ Tool Help Asian 3 Driveability
Easy Scroll European » Transmission
Charge Battery ABS
Connect to PC
i Run...
Shop Info
System Info
112707 | 01:08a, |

Figure A-2 Legacy Software selections
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